# The Outlook 2007 Calendar

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OUTLOOK 2007 CALENDAR OVERVIEW</strong></td>
<td>2</td>
</tr>
<tr>
<td>Find the Calendar</td>
<td>2</td>
</tr>
<tr>
<td>Types of Calendar Entries</td>
<td>3</td>
</tr>
<tr>
<td>Navigate in the Calendar</td>
<td>4</td>
</tr>
<tr>
<td>Change the number of days displayed</td>
<td>4</td>
</tr>
<tr>
<td>Jump to a date</td>
<td>5</td>
</tr>
<tr>
<td>Move to the next or previous appointment</td>
<td>5</td>
</tr>
<tr>
<td><strong>APPOINTMENTS</strong></td>
<td>5</td>
</tr>
<tr>
<td>Create an appointment from the Day view</td>
<td>5</td>
</tr>
<tr>
<td>Create an appointment using the New button</td>
<td>6</td>
</tr>
<tr>
<td>Make an appointment private</td>
<td>7</td>
</tr>
<tr>
<td>Set a reminder</td>
<td>7</td>
</tr>
<tr>
<td>Indicate when you are free or busy</td>
<td>8</td>
</tr>
<tr>
<td>Assign a color category to a calendar appointment</td>
<td>9</td>
</tr>
<tr>
<td>Recurring Appointments</td>
<td>10</td>
</tr>
<tr>
<td>Create a recurring appointment</td>
<td>11</td>
</tr>
<tr>
<td>Change an appointment, Event, or Meeting</td>
<td>12</td>
</tr>
<tr>
<td><strong>MEETINGS</strong></td>
<td>12</td>
</tr>
<tr>
<td>Schedule an in-person meeting</td>
<td>13</td>
</tr>
<tr>
<td>Make a meeting recurring</td>
<td>13</td>
</tr>
<tr>
<td>Make a meeting private</td>
<td>14</td>
</tr>
<tr>
<td>Set up or remove a reminder</td>
<td>14</td>
</tr>
<tr>
<td>Change a meeting</td>
<td>14</td>
</tr>
<tr>
<td>Prevent Meeting Request Replies</td>
<td>14</td>
</tr>
<tr>
<td>Turn off meeting request responses</td>
<td>15</td>
</tr>
<tr>
<td>Turn off responses after you send the meeting request</td>
<td>15</td>
</tr>
<tr>
<td>Respond to a Meeting Request or Notification</td>
<td>15</td>
</tr>
<tr>
<td>Propose a new time</td>
<td>16</td>
</tr>
<tr>
<td><strong>EVENTS</strong></td>
<td>17</td>
</tr>
<tr>
<td>Create an Event</td>
<td>17</td>
</tr>
<tr>
<td>Set an event to recur</td>
<td>17</td>
</tr>
<tr>
<td>Make an event private</td>
<td>18</td>
</tr>
<tr>
<td>Set or remove a reminder</td>
<td>18</td>
</tr>
<tr>
<td><strong>TASKS</strong></td>
<td>18</td>
</tr>
<tr>
<td>Create a task in the Daily Task List in Calendar</td>
<td>19</td>
</tr>
<tr>
<td>Make a task recur</td>
<td>19</td>
</tr>
<tr>
<td><strong>VIEW CALENDARS SIDE-BY-SIDE OR OVERLAIRED</strong></td>
<td>21</td>
</tr>
<tr>
<td>About viewing multiple calendars</td>
<td>21</td>
</tr>
<tr>
<td>Open a calendar in a new window</td>
<td>21</td>
</tr>
<tr>
<td>Open a calendar in side-by-side view</td>
<td>21</td>
</tr>
<tr>
<td>Overlay the calendars</td>
<td>22</td>
</tr>
<tr>
<td>Remove a calendar from the overlay stack</td>
<td>22</td>
</tr>
<tr>
<td>Close additional calendars</td>
<td>22</td>
</tr>
<tr>
<td><strong>PRINTING</strong></td>
<td>23</td>
</tr>
<tr>
<td>Print a Calendar showing Appointments and Meetings</td>
<td>23</td>
</tr>
<tr>
<td>Print blank calendars</td>
<td>24</td>
</tr>
</tbody>
</table>

The Outlook 2007 Calendar Training Session Handout

Microsoft Outlook Help is the source for most topics in this handout.
Outlook 2007 Calendar overview

When you write something down in a paper calendar, you don't have much choice about how it's done. You take your pencil — or your pen, if you're brave — and you write it down. Simple.

In Outlook you have choices - between meetings and appointments, for example, or between once and repeatedly. You can mark scheduled time as busy, free, or tentative. And if you choose, when it's time to go to a meeting, Outlook will remind you.

You can schedule activities in your Outlook calendar as appointments, meetings, events, or tasks. Your choice of entry type will depend on who else is involved and how you want the entry to appear. By selecting entries in your calendar correctly, you'll know at a glance what's going on, when, and with whom.

Find the calendar

Before you can see what's in your calendar, you need to know how to find it. Here are two quick ways to see the calendar:

- Click Calendar in the lower left section of the Navigation Pane.

- Click a date on the Date Navigator (which you'll find on the right side of your workspace, at the top of the To-Do Bar).

The To-Do Bar is available in all Office Outlook 2007 views, so you have access to the information whether you’re working in the Calendar, Tasks, Mail, or one of the other views.
Once you are looking at your calendar, you can use the buttons at the top of the window to navigate and to show or hide detail:

1 Click **Day**, **Week**, or **Month** to quickly switch views.

2 **Forward** and **Back** buttons allow you to easily move through your calendar.

3 More buttons let you show or hide days or detail, depending on your view.

### Types of calendar entries

You'll choose from four types of entry. By knowing the different types, you can be more effective when you schedule your activities.

1 **Appointment**: An appointment is an activity that involves only you, at a scheduled time.

2 **Meeting**: A meeting occurs at a scheduled time, like an appointment. The difference is that you invite other people by using a meeting request that's sent via e-mail.

3 **Event**: An event is an activity that lasts all day long. Unlike an appointment or meeting, an event doesn't block out time in your calendar. With an event, you can still have other entries appear in your schedule for that day.

4 **Task**: A task is an activity that involves only you, and that doesn't need a scheduled time. New to Outlook 2007 is an area in your calendar's Day and Week views that shows tasks.

Use an appointment when you know you'll be busy but no one else is involved. You might enter an appointment to block out time in your calendar for research on a project, for writing a report, or for running an errand on the way home from work.
Navigate in the Calendar

Change the number of days displayed
The Day, Week, Month buttons allow you to choose the number of days that are displayed in the Calendar.

Day view
The Day view shows one day at a time. To move to the next day or previous day, you can use the back and forward navigation buttons ⦅ ⦆.

Week view
The Week view has three display choices:

I. The Show Work Week view displays the days that you select in the Calendar Options dialog box. This view is selected by default.

II. The second display choice in the Week view displays the full seven-day week. You can switch between the customized work week view and the full week view by selecting the appropriate option next to the Day, Week, and Month buttons.

III. The third display choice in the Week view displays one to 10 days at a time. For an eight-day week view, click the calendar grid, and then press ALT+8. For a custom week view that displays one to 10 days, press ALT and any number between 0 and 9.

Month view
The Month view includes three options for the amount of detail that you can display in the calendar grid:

Low: This option displays only events in the Calendar. Events are items that are scheduled to last all day and do not have a specific start time or end time.

Medium: This option displays events and appointments. Appointments are represented with a solid bar within the calendar cell relative to the time of day that they are scheduled. A thin horizontal line extends through 12 noon in the cell for each day.

High: This option displays events and appointments. Appointments are listed with their start time, subject, and location.

Note: Depending on the width of your appointment window, you might not see all three types of information with the High option selected.
Jump to a date

- Use the date navigator to move to a new date by clicking a date on the calendar.

- You can also press **CTRL+G** to open the **Go To Date** dialog box.

Move to the next or previous appointment

If your current calendar view contains no appointments, one or both appointment navigation buttons appear on the edges of the calendar. When you click either of these buttons, the calendar view changes to the next or previous appointment.

**Note:** If there is no next or previous appointment, the calendar navigation buttons are not available.

Appointments

Appointments are activities that you schedule in your calendar that do not involve inviting other people or reserving resources. You can schedule recurring appointments, view your appointments by day, week, or month, and set reminders for your appointments.

You can specify how the appointments in your calendar look to others by designating the time of the appointment as busy, free, tentative, or out of office. Also, others can give you permission to schedule or make changes to appointments in their calendars.

Create an appointment from the Day view

One quick way to start an appointment (or any calendar entry, for that matter) is to rest the pointer over the desired time in **Day** view, click, and type the details in the new **Click to Add Appointment** feature.

1. Rest the pointer over the desired time in your calendar and click.
2. Type the details.
3. Need more time for your appointment? Simply drag the handle to make the appointment longer.
Create an appointment using the New button

1) On the File menu, point to New, and then click Appointment.

   **Keyboard shortcut:** To create an appointment, press Ctrl+Shift+A.

2) In the Subject box, type a description.

3) In the Location box, type the location.

4) Enter the Start and End times.

   **Tip:** You can type specific words and phrases in the Start time and End time boxes instead of dates. For example, you can type Today, Tomorrow, New Year’s Day, Two Weeks from Tomorrow, Week from Yesterday, Three days before New Year's Day, and most holiday names.

5) Select any other options that you want.

   a) For example, to indicate to people who are viewing your calendar that you are Free, have something Tentatively scheduled, you are Busy, or Out of Office, do the following: on the Appointment tab, in the Options group, choose an option from the Show As list.

   ![Appointment options](image)

   The appointment form below includes a Subject, Location, and Start/End times.

   **Additional options applied:**
   - The appointment has been marked Private.
   - Reminder = 1 day
   - Show As = “Out of Office”
   - Categorize = “Personal”
   - A note has been added to the Message section.

6) On the Appointment tab, in the Actions group, click Save & Close.

   - The appointment will look like this on your calendar (in Week view)

   ![Appointment on calendar](image)

   - The item displays the following: Subject; Location; a “lock” icon indicates this appt. has been marked Private; the purple bar on the left side of the box indicates that the appt. “Show As” option is Out of Office; the pink color applied to the appointment item is the color the user chose for their “Personal” Category.
**Make an appointment private**

1) Create or open the appointment that you want to make private.

2) On the **Appointment** tab, in the **Options** group, click **Private**.
   
   **Keyboard shortcut:** To mark an item private, press Alt+H, V.

**Set a reminder**

When you create any type of calendar entry, a reminder is set automatically. Outlook will notify you of appointments and meetings 15 minutes before they start. In the picture, we've shown the steps to change the reminder time for any calendar entry by opening the entry and adjusting the settings in the Reminder box on the Appointment tab.

![Reminder](image)

1. Double-click the appointment to open it.
2. Choose the reminder time.
3. A reminder appears at the specified time.

Do one of the following:

1) **For all new appointments that you create:**
   
   a) On the **Tools** menu, click **Options**
   
   b) To automatically turn a reminder on or off for new appointments, select or clear the Default reminder check box.
   
   c) If you select the check box, enter the amount of time before the appointment that you want the reminder to appear.

2) **For existing appointments:**
   
   a) Open the appointment, or, if the appointment recurs, open the series.
   
   b) To turn a reminder on or off, on the **Appointment** tab, in the **Options** group, in the **Reminder** list, click **None** or the time that you want to be reminded in advance of the appointment.

**Tip:** To customize the sound that is played when a reminder is displayed, in the **Reminder** list, at the end of the list click **Sound**, click **Browse**, select the sound file to play, click **Open**, and then click **OK**.

The Outlook 2007 Calendar Training Session Handout

Microsoft Outlook Help is the source for most topics in this handout.
**The Reminder dialog box**

At the scheduled time set in your appointment, the Reminder dialog box appears.

Respond to the reminder dialog box in the following ways:

**Dismiss All** = If more than one item is displayed in the dialog box, you can dismiss all of the reminders at once. This means you will not be reminded about these items again by Outlook.

**Open Item** = Allows you to open the selected item so that you are able to view more details before responding to the reminder dialog box.

**Dismiss** = Dismisses only the selected item in the dialog box. You will not be reminded again about this item by Outlook.

**Snooze** = Allows you to set another reminder for the selected item.

---

**Indicate when you are free or busy**

When you schedule a meeting, you want to choose a time when people can attend. Outlook lets you and your colleagues tell each other who's busy, who's out of the office, who's free — and when.

The border color of a calendar entry indicates whether that time is scheduled as **free**, **tentative**, or **out of office**.

Newly created appointments and meetings are automatically entered as busy, and events are automatically entered as free. By keeping this information current and accurate, you'll benefit from features that let you share your schedule with others.

**Notes:**

- If you change the time setting for an event from free to anything else, the whole day for that event will appear shaded.
- If you change the time setting for a meeting you didn't create, your change will be overwritten if the meeting organizer updates the time of the meeting.
Assign a color category to a calendar appointment

Want birthdays to catch your eye and personal appointments to stand out from business appointments? Outlook can make it happen. Introducing...colored categories! Colored categories let you name your colors (and change the names when you want to). Use colors to make certain entries stand out at a glance.

You can track all items related to a particular project or task by using color categories to easily identify and organize the items. Besides calendar items, you can assign color categories to contacts, messages, tasks, notes, and journal items.

A category must be listed in the color category list before you can assign it. If it is not listed, you can simultaneously create a new color category and assign it to an item for the first time. You can also choose from several default color categories and rename them to be more meaningful to you.

To assign a color category, do the following:

- **For an appointment in your Calendar**: Right-click the appointment, point to Categorize, and then click a color category.

- **For an open appointment**: On the Appointment tab, in the Options group, click Categorize, and then click a color category.

- **For an open meeting request**: On the Meeting tab, in the Options group, click Categorize, and then click a color category.

- **For an open recurring meeting request**: On the Recurring Meeting tab, in the Options group, click Categorize, and then click a color category.

- **To see more categories or to create a new category**: click All Categories to open the Color Categories dialog box. To assign a color category from the Color Categories dialog box, you must select the check box next to the color category. The Color Categories dialog box is also a quick way to assign multiple categories to an item.

Notes:

- You can change the color associated with a category at any time.

- Another way to open the Categorize menu and Color Categories dialog box is by clicking Categorize on the toolbar.

- Only the 15 most recently used color categories appear on the Categorize menu. To see the rest, click All Categories on the Categorize menu.
Recurring appointments
To tell Outlook that an appointment, meeting, or event occurs over, and over, and over, you use the Recurrence feature. The frequency of the activity is called its recurrence pattern.

As you can see with the Exercise appointment in the picture, a recurring appointment appears repeatedly and displays a recurrence icon.

To set up a recurrence pattern, open the appointment and click the Recurrence button in the Options group of the Appointment tab.

Clicking the Recurrence button displays the Appointment Recurrence dialog box.

Use this dialog box to set the recurrence pattern.

- What time does the appointment occur? (Appointment time)
- How often does it occur? (Recurrence pattern)
- How long should the appointment be scheduled for? (Range of recurrence)
To open a recurring calendar entry to see its details or to change it, you'll double-click it. When you do this, you'll see a message like the one in the picture, which gives you two options:

**Open this occurrence**: Choose this option when you want to see or change one instance, not the entire series. On one particular day, for example, you might want to exercise a half-hour later than usual, without changing the usual time.

**Open the series**: Choose this option when you want to see or change the entire series — if, for example, you decided to shift all instances of your "Exercise" appointment by half an hour.

After the series is open, to change its recurrence pattern, click the **Recurrence** button on the **Appointment** tab.

**Tips** - Keep these in mind when you work with recurring items:
- Don't delete a recurring entry. Instead, change the "End by" time. This leaves you with a record of past occurrences.
- You may need to create several different recurring calendar entries to achieve the desired pattern for a single activity. For example, if you want to set up a payday event that occurs on the 15th day of the month and also on the last day of the month, you will need to set up two recurring events for that.

**Create a recurring appointment**

1) Open the appointment that you want to set to recur.
2) On the **Appointment** tab, in the **Options** group, click **Recurrence**.
   a) Click the frequency — **Daily**, **Weekly**, **Monthly**, **Yearly** — with which you want the appointment to recur, and then select the options for the frequency, click **OK**
3) On the **Appointment** tab, in the **Actions** group, click **Save & Close**.
Change an appointment, event, or meeting

1) Open the appointment, event, or meeting that you want to change.
2) Do one of the following:
   a) **Change options for an appointment that is not part of a series:**
      - On the **Appointment** tab, change the options, such as subject, location, and time that you want to change, and then click **Save and Close**.
   b) **Change options for all items in a series:**
      - In the **Open Recurring Item** dialog box, click **Open the series**.
      - On the **Appointment** tab, change the options, such as subject, location, and time.
      (1) **To change recurrence options:** on the **Appointment** tab, in the **Options** group, click **Recurrence**. Change the options, such as time, recurrence pattern, or range of recurrence, and then click **OK**.
      - Click **Save and Close**
   c) **Change options for one item that is part of a series:**
      - In the **Open Recurring Item** dialog box, click **Open this occurrence**.
      - On the **Appointment** tab, change the options, such as subject, location, and time, and then click **Save and Close**.

**Tip:** In Calendar, you can drag the appointment, event, or meeting to a different date. You can also edit the subject by clicking the description text and typing your changes. You can change an event into an appointment, causing the time to be blocked out in your calendar, by clearing the **All day event** check box and then entering the start and end times of your choice. Events are defined as lasting from midnight to midnight, clearing this check box allows you to enter specific start and end times.

**Meetings**

A meeting is an appointment to which you invite people and/or reserve resources for. You can create and send meeting requests and reserve resources for face-to-face meetings or for online meetings. When you create a meeting, you identify the people to invite and the resources to reserve, and you pick a meeting time. Responses to your meeting request appear in your Inbox. You can also add people to an existing meeting or reschedule a meeting.

A meeting in your calendar could be one you set up, or it could be one you’ve been invited to by someone else. Meetings appear both in your calendar and in the calendars of the other people who are involved.

In your calendar, you can tell the difference between a meeting and an appointment by the information in the meeting entry. In a meeting you'll see these:

1. The location of the meeting
2. The meeting organizer's name
   (depending on your version of Exchange, you may not see the organizer’s name in the calendar view.)
A meeting in Outlook is set up with the help of a meeting request, which is delivered to the meeting participants via e-mail.

**Schedule an in-person meeting**

1) On the **File** menu, point to **New**, and then click **Meeting Request**.

   **Keyboard shortcut:** To create a new meeting request, press **Ctrl+Shift+Q**.

2) In the **Subject** box, type a description.

3) In the **Location** box, type a description.

4) In the **Start time** and **End time** lists, select the start and end time for the meeting. If this is an all day event, select the **All day event** check box.

   **Note:** By default, the current time zone setting on your computer system is used to schedule meetings. If you want to schedule meetings based upon an alternate time zone, on the **Meeting** tab, in the **Options** group, click **Time Zones**.

5) Type any information that you want to share with the recipients and attach any files.

6) On the **Meeting** tab, in the **Show** group, click **Scheduling Assistant**.

   a) The **Scheduling Assistant** helps to find the best time for your meeting.

   b) Click **Add Others**, and then click **Add from Address Book**.

      - In the **Select Attendees and Resources** dialog box, in the **Search** box, enter the name of a person or resource that you want to invite to the meeting.

      - Select the name from the results list, and click **Required, Optional**, or **Resources**, and then click **OK**.

9) Click **Send**.

7) **If you want to make the meeting recur:** on the **Meeting** tab, in the **Options** group, click **Recurrence**, select the recurrence pattern, and then click **OK**.

   **Note:** When you add a recurrence pattern to a meeting request, the **Meeting** tab changes to **Recurring Meeting**.

8) On the **Meeting** tab, in the **Show** group, click **Appointment**.

9) Click **Send Update**.

**Make a meeting recurring**

1) Open the meeting that you want to make recurring.

2) On the **Meeting** tab, in the **Options** group, click **Recurrence**.

   a) Click the frequency with which you want the meeting to recur, and then select options for the frequency, and then click **OK**.

3) Click **Send Update**.
Make a meeting private
1) Create or open the meeting that you want to make private.
2) On the Meeting tab, in the Options group, click Options, and then click Private.

Set up or remove a reminder
1) Do one of the following:
   a) For all new meetings that you will create:
      • On the Tools menu, click Options.
      • To have a reminder automatically turned on or off for new meetings, select or clear the Default reminder check box.
      • If you selected the check box, enter the amount of time before the meeting that you want the reminder to appear.
   b) For existing meetings:
      • Open the meeting, or series if the meeting is recurring.
      • To have a reminder turned on or off, on the Meeting tab, in the Options group, select None or a listed reminder time.

Change a meeting
1) Open the meeting that you want to change.
2) Do one of the following:
   a) Change options for a meeting that is not part of a series:
      • Change the options, such as subject, location, and time.
      • Click Send Update.
   b) Change options for all meetings in a series:
      • Click Open the series.
      • Change any options, such as subject, location, and time.
      • To change recurrence options, on the Recurring Meeting tab, in the Options group, click Recurrence, change the options, such as time, recurrence pattern, or range of recurrence, and then click OK.
      • Click Send Update.
   c) Change options for one meeting that is part of a series:
      • Click Open this occurrence.
      • On the Recurring Meeting tab, change the options, such as subject, location, and time.
      • Click Send Update.

Prevent meeting request replies
In Microsoft Office Outlook, you can send a meeting request and not track the attendees' responses. Not tracking the responses can be useful when you send a meeting request to a large number of attendees but do not want to know who can and cannot attend.
**Turn off meeting request responses**

1) In a new meeting request, do the following:
   a) On the **Meeting** tab, in the **Attendees** group, click **Responses**.
      
      **Note**: For recurring meetings, the **Meeting** tab appears as the **Recurring Meeting** tab.
   b) Click **Responses** to clear the “**Request Responses**” and “**Allow New Time Proposal**” check boxes.

   **Note**: If you turn off the Request Responses option, you will not be able to track whether attendees have accepted, tentatively accepted, or declined. For instance, when you open the meeting in your calendar, click the **Meeting** tab, and then click **Tracking** in the **Show** group, the “Response” column will display “None” for all of the attendees.

**Turn off responses after you send the meeting request**

Even if you don't turn off the response option when you initially send the meeting request, you can change the option at any time.

1) Open the meeting.
2) On the **Meeting** tab, in the **Attendees** group, click **Responses**.
3) Click **Request Responses** to clear the “Request Responses” and “Allow New Time Proposal” check boxes.
4) Click **Send Update**.

**Respond to a meeting request or notification**

1) Open the meeting request or notification.
2) Do one of the following:
   a) **Accept, tentatively accept, or decline**:
      
      • On the **Message** tab, in the **Respond** group, click ✓ **Accept**, ☉ **Tentative**, or ✗ **Decline**.
      
      **Note**: If you open the meeting from your calendar, on the **Appointment** tab, in the **Respond** group, click **Accept**, **Tentative**, or **Decline**.
   b) Do one of the following:
      
      • Send your response with no comments:
         (1) Select **Send the response now**, and then click **OK**.
      • Include comments with your response:
         (1) Select **Edit the response before sending**.
         (2) Type your comments, and then click **Send**.
      • Don't send a response:
         (1) Select **Don't send a response**, and then click **OK**.

**Note**: When you choose this option, the meeting is added to your calendar, but the organizer will not know the choice that you made. If the meeting organizer did not send you the meeting request directly and you received it as a forwarded request from someone else, you will not receive any updates to the meeting unless you respond. This is because the meeting organizer does not know that you have been invited. Also, in the absence of responses, the meeting organizer will not have an accurate count of the number of people attending the meeting.
Propose a new time

1) On the Message tab, in the Respond group, click Propose New Time. **Note:** If you open the meeting from your calendar, on the Appointment tab, in the Respond group, click Propose New Time.

2) Click either Tentative and Propose New Time or Decline and Propose New Time.

3) Click a time when all invitees are available. You can use AutoPick Next to find the next available free time for all invitees.

4) Click Propose Time.

5) Click Send.

**Note:** Whenever you propose a new time, it is sent with a default message that says you want to propose a new time, but that you have tentatively accepted the meeting. You can change this default message to say that you want to propose a new time, and that you are accepting or declining the meeting. Do the following:

1) On the Tools menu, click Options, and then click Calendar Options.

2) In the Use this response when you propose new meeting times list, click the setting that you want. **Note:** You can also change this setting for individual meetings. In the open meeting request, on the Message tab, in the Respond group, click either Tentative and Propose New Time or Decline and Propose New Time. If you open the meeting from your calendar, on the Appointment tab, under Respond, click either Tentative and Propose New Time or Decline and Propose New Time.

Notes:

- New meeting requests appear as tentatively accepted on your calendar.
- You can change your acceptance status at any time after you respond to the meeting request. Open the item in your calendar, and on the Appointment tab, in the Respond group, click Accept, Tentative, Decline, or Propose New Time. To accept a request that you previously declined, check your Deleted Items folder for the meeting request, or ask the organizer to either resend the request or send you a new request.
Events
An event lets you note activities that last all day. Events do not occupy scheduled time in your calendar; instead, they appear in banners at the top of the date you specify. An all-day appointment displays your time as busy when viewed by other people, but an event or annual event displays your time as free (however, you can change this option when you create the item).

For example, in the picture, the Contoso Conference is an event lasting three days and the Birthday is an event lasting one day.

Use an event when you want to enter an activity on a specific day without letting it clutter up all of that day's time slots in your calendar. Here are some activities for which you might use an event:

- Conferences, business travel, or vacations, for one day or longer
- Birthdays and anniversaries
- Holidays

Create an event
1) In Calendar, on the Actions menu, click New All Day Event.
2) In the Subject box, type a description.
3) In the Location box, enter the location.
4) To indicate to people who are viewing your calendar that you are out of office instead of free, on the Event tab, in the Options group, click Out of Office in the Show As list.
5) If the event lasts longer than one day, change the values in the Start time and End time boxes.
6) Click Save and Close.

Tip: In Day/Week/Month view, you can quickly create an event by double-clicking the darker shaded area beneath the date heading of the day of the event.

Set an event to recur
1) Open the event that you want to set to recur.
2) On the Actions menu, click Recurrence.
3) Click the recurrence frequency that you want, and then select the options for the frequency.
4) Click OK, and then click Save and Close.
Make an event private
1) Create or open the event that you want to make private.
2) On the Appointment tab, in the Options group, click Private.

Set or remove a reminder
1) Do one of the following:
   a) For all new events that you create:
      • On the Tools menu, click Options.
      • To automatically turn on or off the reminders for new events, select or clear the Default reminder check box.
      • If you select the check box, enter the amount of time before the event that the reminder should appear.
   b) For existing events:
      • Open the event, or the series if the event recurs.
      • To turn on or off a reminder, on the Appointment tab, in the Options group, in the Reminder list, click None or the amount of time before the event that you want a notification.

Tasks
A task is an entry for any activity that you want to see in your calendar, but that doesn't need to be scheduled for a specific time or involve the whole day. You'll see the Tasks area when you look at the calendar in Day or Week view.

For example, if you have a number of errands that you need to do, enter each errand as a task.

When you complete a task, check it off. A completed task will stick to the day on which it's completed, keeping a tidy list of that day's accomplishments at your fingertips.

Notice the completed task has a check mark and a line through it.

You can enter a task with a scheduled start date and due date. If you don't complete a task on its due date, it will automatically move forward and appear on the current day until you reschedule it or check it off.

Tip: To quickly reschedule a task, use the Week view and drag a task from one day to another.
Create a task in the Daily Task List in Calendar
The Daily Task List appears only in the Outlook Calendar day and week views. To toggle the Daily Task List on or off, in Calendar, click View, point to Daily Task List, and then click Normal, Minimized, or Off.

To display only the total number of tasks: do one of the following:
- In Calendar, click View, point to Daily Task List, and then click Minimized.
- Point to the top edge of the Daily Task List. When the pointer becomes a \( \frac{1}{2} \), drag the edge to the bottom of the window.

Tip: To create new tasks in the Daily Task List, you must use the Normal Daily Task List setting.

1) In the Daily Task List, as your pointer hovers, **Click to add task** is displayed.

2) Click any blank space beneath a day column.
3) Type a subject for the task, and then press ENTER.

**Note:** By default, the task will be assigned a Start date and Due date of the day in the column above the Daily Task List. To change the Start date or Due date of the task, drag the created task to the day that the task is due. Instead of dragging the task, you can open the task and then change the start and due dates. To do so, you can right-click the task, and then click Open, or select the item, and then press ENTER.

**Make a task recur**
1) If you want to make the task recur, on the Task tab, in the Options group, click Recurrence.
2) In the Task Recurrence dialog box, click the frequency with which the task should recur, and then do one of the following:
   a) Make the task recur at regular intervals: In the Recurrence pattern section, select the options for the frequency interval that you want. Do not select Regenerate new task or the task will not recur at regular intervals.
   b) Make the task recur based on completion date: Select Regenerate new task, and in the box, type the amount of time after which a new task must be generated.
      - Each time you mark the task complete, a new task will be created based upon your selections.
      **Tip:** This is your best choice when you do not want the next reminder for a task to appear until the previous one is marked complete. If you do not mark the item complete, the next reminder will never appear. For example, if you have a reminder to pay your utility bill on the 15th of each month and you do not mark the occurrence on April 15th as complete, in May you will still see the April 15th task. Once you mark the April 15th task complete, the May 15th occurrence of the task will appear.
   c) Click OK to close the Task Recurrence dialog box.
3) If you want to add a reminder, select the Reminder check box to turn on a reminder alert. Enter the date and time you want for the reminder.
   a) You can specify a custom sound to be played with your reminder. Click \( \) , click Browse, select the sound file to play, click Open, and then click OK. This changes the reminder sound only for this task.
4) If you want to track your progress on this task, in the **Status**, **Priority**, and **% Complete** boxes type or select the options you want.

   a) The **Status** and **% Complete** fields are dependent on each other. By changing the value in one field, the value in the other field changes accordingly.

<table>
<thead>
<tr>
<th>Status</th>
<th>% Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Started</td>
<td>0</td>
</tr>
<tr>
<td>In Progress</td>
<td>1-99</td>
</tr>
<tr>
<td>Completed</td>
<td>100</td>
</tr>
<tr>
<td>Waiting on someone else</td>
<td>0-100</td>
</tr>
<tr>
<td>Deferred</td>
<td>0-100</td>
</tr>
</tbody>
</table>

5) If you want to assign a color category to your task, on the **Task** tab, in the **Options** group, click **Categorize**, and then click one of the entries from the menu. For more color categories, click **All Categories**.

   **Tip:** Changed your mind about a color category assignment? Right-click the color or name of the color category, and then click **Clear Name of Category** or **Clear All Categories**.

6) If your task involves a person or organization in your Contacts, you can create a quick link to the contact, by clicking **Contacts** at the bottom of the window, and then selecting an entry. Click **OK** to close the **Select Contacts** dialog box.

   **Note:** you must have this option turned on to see the Contacts field in your form. If you do not see the Contacts… field, you can turn it on by doing the following:

   - Choose **Tools** from the main Outlook window menu / click **Options**…
   - Under the **Preferences** tab, in the “Contacts and Notes” section, click the **Contact Options**… button
   - In the Contacts Options dialog box, check **Show Contact Linking on all Forms** in the “Contact Linking” section / click **OK** twice.

7) If you do not want other people to see a shared task entry, on the **Task** tab, in the **Options** group, click **Private**.

8) If you want to enter mileage, work hours, and other billing information, on the **Task** tab, in the **Show** group, click **Details**. Type the information in the **Total work**, **Actual work**, **Mileage**, and **Billing information** text boxes.

9) On the **Task** tab, in the **Save** group, click **Save and Close**.

   **Tip:** To move a task up or down on the list, click and drag the item to the position that you want. As you drag the task, a red line with arrows indicates where the task will be placed when you release the mouse button.
View calendars side-by-side or overlaid

About viewing multiple calendars
You can open a second calendar in a new window and display up to 30 calendars in side-by-side view. You can also overlay calendars to see transparent calendars stacked on top of each other. This view is useful when you want to find a common free time slot on several different calendars.

In Calendar, the Navigation Pane shows a list of your calendars under My Calendars. This list includes your default primary calendar in Outlook that displays your free/busy time to other people, and where meeting requests that you accepted are saved.

Other calendars, or secondary calendars, can include calendars that you created to track a project, a personal schedule, or some other calendar event that you do not want to mix with the items on your default calendar. For example, your default calendar might be your calendar for work, and your second calendar might track your child's soccer team schedule.

Note: When you share your default calendar, appointments on secondary calendars are not displayed to other people and do not affect your free/busy availability.

Open a calendar in a new window
1) In Calendar, in the Navigation Pane, right-click the name of another calendar that you want to view.
2) Click Open in New Window.
3) The calendar that you selected opens in a new Outlook window.

Open a calendar in side-by-side view
1) In Calendar, in the Navigation Pane, select the check box of another calendar that you want to view.
2) The calendar that you selected opens next to the calendar that is already displayed.

Note: At least one calendar must always be displayed
Overlay the calendars
1) In Calendar, in the Navigation Pane, select the check box of another calendar that you want to view.
   Note: The calendar that you selected opens next to calendar that is already displayed.
2) Repeat step 1 for each calendar that you want to view.
3) On the Calendar tab, click .
4) The calendars are now in overlay mode.
5) To add another calendar to the overlay, repeat this step.

Remove a calendar from the overlay stack
1) In Calendar, on the tab of the calendar that you want to remove from the overlay stack, click .
2) The tab moves back to the right. The calendar that you selected is no longer displayed in overlay mode.
3) Repeat step 1 for each calendar that you want to remove from the stack.

Close additional calendars
1) In the Navigation pane, click the checkbox for the calendar you no longer need to see (to deselect it).
Printing

Print a calendar showing appointments and meetings

1) On the File menu, click Print and then in the Print style box, click the print style you want.
   a) For example, to print the details of appointments and meetings, in the Print Style box, click Calendar Details Style

2) In the Start list and the End list, enter the first day and the last day to print.

   Notes:
   • To print the details of private appointments, clear the Hide Details of private appointments check box.
   • To print non-adjacent days, change to Week or Month view, select the days you want to print, and then on the File menu, click Print.

3) To set other print options, such as the paper orientation or the fonts used, click Page Setup, and then select the options that you want.

   Notes:
   • To print the details of private appointments, clear the Hide Details of private appointments check box.
   • To print non-adjacent days, change to Week or Month view, select the days you want to print, and then on the File menu, click Print.
Print blank calendars
You can use Microsoft Office Outlook to print a blank calendar. Blank calendars may be useful to take notes on or to consult when you meet to discuss a project with your team.

1) On the File menu, point to New, and then click Folder.
2) In the Create New Folder dialog box, in the Name text box, type a name for the folder.
3) In the Folder contains list, click Calendar Items.
4) In the Select where to place the folder list, click Calendar, and then click OK.
5) In Calendar, in the Navigation Pane under the My Calendars section, select the check box for the calendar you created.
6) On the File menu, click Print.
7) In the Print dialog box, under Print this calendar, click the calendar you created.
8) Select the print style options you want, and then click OK.

Calendar symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌚️</td>
<td>Recurring item: An appointment or meeting that recurs on a specified schedule.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Exception to recurring item: An item, such as an appointment or meeting, that is part of a recurring series but is an exception to the recurrence pattern.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Data conflict: A conflict exists between the data on your local computer and the server running Microsoft Exchange. To resolve the conflict, open the item and follow the instructions on your screen.</td>
</tr>
<tr>
<td>⛔️</td>
<td>Private item: The item is marked as private to prevent other people from viewing its details.</td>
</tr>
<tr>
<td>⌂️</td>
<td>Meeting Workspace: A Meeting Workspace is associated with this item.</td>
</tr>
<tr>
<td>📄</td>
<td>File attachment: A file attachment is associated with this item.</td>
</tr>
</tbody>
</table>